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Abraham Lake

by Alice Pritchard, Gleneath Camera Club
Best Landscape Slide, 2005 Outing Competition
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PRPA Executive for 2005-2006
Chairperson

Wilma Gamble

2403 24A St. SW, Calgary AB T3E 1V9
403-246-8343 wrgamble@shaw.ca
Secretary
Shirley Gerlock 2471 Broder Street, Regina SK S4N 3T1
306-757-3328 sjgerlock@accesscomm.ca
Treasurer
Wesley Swan
Box 154, Nipawin SK S0E 1E0
306-862-4135 treasurer@prpa.ca
Membership
Irene Stinson
449-2nd Avenue SE, Swift Current SK S9H 3J7
306-773-7320 istinson@sasktel.net
Competitions
Eldred Stamp
5902-58 Ave., Panoka, AB T4J 1L4
403-783-3299 eldred1@telus.net
Newsletter
Stan Hingston
Box 1177, Rosetown SK S0L 2V0 sghingston@sasktel.net
Res: 306-882-2263 Work: 882-2220 Fax: 882-2370
Slide Circuit
Christopher Dean 908 Saskatchewan Crescent East, Saskatoon SK S7N 0L5
306-652-7262 c.j.dean@shaw.ca
Print Circuit
Jeanette Dean
as above
Print Exhibition Alfred Labrecque Box 1777, Rosetown SK S0L 2V0
306-882-2261
Past President
Gordon Hunter
715 Deercroft Way SE, Calgary AB T2J 5V4
403-271-4039 ge.hunter@shaw.ca

PRPA Club Representatives
Central Alberta Photo Society Curtiss Lund
403-347-2709
clund1@telus.net
Battlefords Photo Club
Heather Anderson
306-445-5315
haha@sasktel.net
Caroline Clickers
Dan Jahraus
403-729-2172
Foothills Camera Club
Janice Meyers-Foreman 403-289-7617
meyersjb@telus.net
Gateway Camera Club
Isabel Hill
780-475-2317
Gleneath Camera Club
Sheila Keller
306-463-3940
Image West Photo Assn. (Sw. Current) Arlyne Lawson 306-773-7561
Moose Jaw Camera Club
Sheina Wait
306-692-8218
Nipawin Camera Club
Wesley Swan
306-862-4135
wesley@swanphotography.ca
Northern Image Photographers (PA) Geoff Payton 306-922-3394
Geoff.Payton@shaw.ca
Parkland Camera Club (Tisdale) Darlene McCullough 306-873-2030
darlene.mccullough@sasktel.net
Regina Photo Club
Shirley Gerlock
306-757-3328
sjgerlock@accesscomm.ca
Rosetown Photography Club Stan Hingston
306-882-2220
sghingston@sasktel.net
Saskatoon Camera Club
Maureen Sinclair
306-955-2373
maureen.sinclair@sasktel.net
Wild Rose Camera Club (Red Deer) Verna Allison 403-749-2003
lvson2@telusplanet.net
Winnipeg South Photo Club Tyrrell Mendis
204-774-0677
tymendis@shaw.ca

Club Websites
PRPA
Central Alberta Photo Society
Foothills Camera Club
Moose Jaw Camera Club
Nipawin Camera Club
Northern Image Photographers
Parkland Camera Club
Regina Photo Club
Rosetown Photography Club
Saskatoon Camera Club
Winnipeg South Photo Club

http://prpa.ca/
www.mycommunityinformation.com/caps
www.foothillscameraclub.ab.ca
www.geocities.com/moosejawcameraclub
www.nipawincameraclub.com
http://niphoto.tripod.com
www.parklandphotographyclub.com
www.reginaphotoclub.com
rpc@reginaphotoclub.com
www.rosetownphotoclub.com
www.saskatooncameraclub.com
www.winnipegsouthphotoclub.ca
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A Message from your Chairperson
by Wilma Gamble

As spring approaches, I find myself anticipating,
with some excitement, the fact that we will soon be
able to go in search of spring flowers, watch for the
return of birds, and be awed by the beautiful green
hues that will cover our hills and fields. But before
this happens, I always pull out my camera's manual
to refresh my memory of its operation and the different functions available to me.
Also, I find myself reading a few of my favourite
books for inspiration. I have many but probably my
favourites and most read are three books by Freeman
Patterson. "Photography for the Joy of It", Photography and the Art of Seeing" and Photography of Natural Things". They sometimes travel with me and
around home are always close at hand.
Congratulations to all winners of the Everest,
Russell and Travelling Salon slide competitions. Some wonderful images and a real challenge
for us to take prize winning photos to have ready for
next season's competitions. A big THANK YOU
goes out to all the judging clubs and to everyone who
entered the competitions. You make our organization what it is.
As a final word—and I will paraphrase a few
noted photographers—when taking an image, always
turn around 180 degrees to consider the view behind
you. You will sometimes be amazed at what might
have been missed.

The Challenge Cup

report by Stan Hingston
The Rosetown Photography Club has challenged
Foothills Camera Club for the coveted Challenge
Cup. The theme is “abandoned”, medium is prints,
and deadline November 1, 2006. Gleneath Camera
Club has kindly agreed to judge the competition.
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Competition Chair Report
by Eldred Stamp

As this year’s Outing fast approaches (to held in
Saskatoon June 9-11) my workload increases: trophies to obtain, certificates to make, and competitions to tally and organize. I would like to thank all
judging clubs for their contribution to PRPA and for
presenting the competition results in a way I can use
and record them. It makes my job easier in the timeconstraints I have.
Before I forget, I hope to see you at the Outing
and hopefully you will have a slide show to present
to the members. It’s a great time to show your pictures to others in the ten minute time-frame given for
each person’s presentation. Please let the Outing coordinator know that you will be entering by May 1.
Also, should you need information regarding the
competitions, each club has a Competitions Handbook with all the necessary forms in it. These forms
can also be found on our web site at www.prpa.ca
The slide show for last year is still on tour. If you
haven’t already seen it, look for it coming to your
club soon.
Just a reminder, the Russell theme is “fast/slow”
for this year (Fall 2006) and “tidy/untidy“ for 2007 .
Hope to see you at the Outing. Your pictures will
be a pleasure to see.

Abandoned Farms
Photographers and painters seem to like abandoned farms:
Weather-beaten grain bins, gray houses and stone barns,
Wagon wheels, rusted trucks, discarded farm machines —
Can’t people see the sadness of someone’s broken dreams?

Regarding the theme, my oldest brother Allen
takes exception to people photographing and painting abandoned farm buildings and machinery. He
believes that treating them as merely quaint artistic
subjects is insensitive to the broken dreams of the
farmers that once lived there.

What farmer hasn’t dreamed his farm would always
carry on;
Or children planned to farm the land, when it became
their own?
But quarrels, death or markets; hail, drought or early frost,
A dozen things take farm or farmer and the dream is lost.

In response to a photo (next page) of the old
Hingston farmhouse (where my father was born in
1921 and we lived until I was 13) taken by my other
brother Ross last spring, Allen composed the following poem. Anyone care to pen a rebuttal from the
photographer’s point of view?

Where people once planned next year’s crops with hopeful
smile or laugh,
Another empty farm house stands, to paint or photograph.
Allen Hingston 2006

Prairie Focus

Spring 2006

Print and Slide Circuit Results
by Chris and Jeanette Dean

Here are the results from the first round of the Print and
Slide Circuits for 2005-6.
Print Circuit #1
1 Curtiss Lund Showy Lady Slipper
2 Dylan Nash A Cossack's Lullaby
3 Curtiss Lund Killdeer
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2005 Outing Competition Results
Goldeye Centre, Nordegg, Alberta
Submitted by Verna Allison

The following prints and slides were selected by the
judging panel of the host club Wild Rose. The first place
in each category (10 photos) can be found on the cover of
this issue. Numbers in [ ] refer to photo # on back cover;
[FC] refers to front cover. Congratulations to the winners!

Print Circuit #2
1 Heather Anderson White on White
2 Hazel Rauch Sunrise
3 Heather Anderson Daughter of Ra

Print Competition
Landscapes
1. Landscape [1]
Mabel Edler, Wild Rose
2. Little Church on the Hill Joyce Nelson, Moose Jaw
3. Windy Point on Abraham Lake Alice Pritchard,
Gleneath

Print Circuit #3
1 Eldred Stamp Rachel
1 Don Matheson Rushes and Moon
2 Eldred Stamp Poppies
3 Ted Senger Table Top

Goldeye Centre
1. Goldeye Centre [2]
2. Rain-filled Canoes
3. Goldeye Centre
HM Rooms

Print Circuit #4
1 Marlyn Toderan Decorated Threshing Machine
2 Mary Jacobs Acia Tree at Sunset
3 Marlyn Toderan The Trinity
Slide Circuit #1
1 Vern Sanders Hafford Church
2 Jean Harris Church and Dorothy
3 Mabel Elder Mug Shot
3 Alfred Hauk Horse Power
Slide Circuit #2
1 Wilma Gamble Venus' Slipper
2 Wilma Gamble Concretion at Red Rock Coulee
3 Wilma Gamble Sheep River Falls
Slide Circuit #3
1 Gordon Johnson Reflection
2 Gordon Johnson Ruffed Grouse
3 Curtiss Lund Tree Frost

Farm Sunset
by Ross Hingston, 2005
(see poem page 3)

Eldred Stamp, Wild Rose
Alice Pritchard, Gleneath
Darlene McCullough, Parkland
Wesley Swan, Parkland

Historical
1. Historical [3]
Eldred Stamp, Wild Rose
2. Bricks Collecting Dust Verna Allison, Wild Rose
3. Rusty Rhythms
Joyce Nelson, Moose Jaw
Flora/Fauna
1. Lonesome Pine [4]
2. Flora/Fauna
3. Mutant Evergreen
HM Logs
HM Venus Slipper

Anne McIntosh, Parkland
Eldred Stamp, Wild Rose
Joyce Nelson, Moose Jaw
Mabel Edler, Wild Rose
Curtiss Lund, Wild Rose

Candid Portrait
1. In Focus [5]
2. Eldred
3. Candid Portrait

Joyce Nelson, Moose Jaw
Curtiss Lund, Wild Rose
Eldred Stamp, Wild Rose

Slide Competition
Landscapes
1. Abraham Lake [FC] Alice Pritchard, Gleneath
2. Beginning of Abraham Lake Jean Harris, Gleneath
3. Abraham Lake
Rella Lavoie, Gleneath
Goldeye Centre
1. Cabin Anyone? [6]
2. Idle in the Rain
3. Goldeye Centre

Mabel Edler, Wild Rose
Jean Harris, Gleneath
Darlene McCullough, Parkland

Historical
1. Cable at Rust [7]
2. Once Turned
3. The Hub

Dale McKenzie, Wild Rose
Mabel Edler, Wild Rose
Virginia McKenzie, Wild Rose

Flora/Fauna
1. Flora Overview [8]
2. Lady Slipper
3. Three of a Kind

Darlene McCullough, Parkland
Mabel Edler, Wild Rose
Wesley Swan, Parkland

Candid Portrait
1. Candid Portrait [9]
2. Serenity
3. Fearless Leader

Darlene McCullough, Parkland
Joyce Nelson, Moose Jaw
Mabel Edler, Wild Rose
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PRPA Executive Meeting, October 2005
report by Stan Hingston
from minutes by Shirley Gerlock

Rosetown Photography Club hosted the October 1,
2005, PRPA executive meeting in the Rosetown library
basement where the club meets on a monthly basis. There
were 12 members of the PRPA executive and club reps in
attendance along with two guests from the Rosetown club
and two from Regina.
A sheet of revisions to the PRPA Handbook is to be
published and distributed to members in 2006 instead of
reprinting it again. Eldred and Stan are to review the handbook and request suggestions from members through the
newsletter.
Shirley Gerlock offered to get a quote from Office
Depot in Regina for printing the newsletter. A motion was
carried that if the quote is $50 less than Economy Stationery that we get the newsletter printed there.
A website competition committee was formed with
Wesley, Curtiss, Stan and Eldred to set up a trial competition on the website and to report at the April executive
meeting. A digital competition similar to the Curtiss Lund
Trophy print competition was suggested.
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CLUB REPORTS
Image West Photographic Association
report by Arlyne Lawson

Our club meets once a month on the fourth Tuesday
with the exceptions of July, August and December. We
have nine members as of February 2006.
In January 2005 we began planning for our centennial
photographic options by inviting Kim Houghtaling, curator of the art gallery, to our meeting. He told us that a display in the gallery would be on an invitational and juried
basis and that all photographic mediums (prints, transparencies, albums, etc) would be accepted.
Our Centennial display at the gallery took place in late
August with a grand opening that featured wine and
cheese and a walk-about with the artists. It was exhibited
for a month with six of our members participating.
At our April meeting a member presented a slide show
on the Yucatan Peninsula which was thoroughly enjoyed.
We held a photo outing at Saskatchewan Landing Provincial Park on June 5th, which at this time of year provided many opportunities for the creative photographer.

Wild Rose submitted a check to PRPA for $768 for
proceeds from the Nordegg Outing.

Only one of our members was able to attend the PRPA
Outing at the Goldeye Center, near Nordegg, Alberta.

It was agreed to hold a secret mail-in ballot prior to the
AGM to decide on the CAPA amalgamation proposal.

A lottery grant enabled us to purchase a slide projector, screen, light table and a quantity of slide film. Each
member received a roll of film with the instruction that it
be shot at a place where he or she had not been before.

Prairie Focus back issues
I have extra copies of most of the newsletters that I
edited. Contact me if you are missing any from your collection. Alternatively I am collecting older back issues
(Volume 38 and earlier). If you are cleaning house, don’t
throw away that box of old PRPA material—bring it to
the Outing and donate it to the PRPA archives.

Two of our members attended the Camera Canada
College in Regina in September. They gave our club a
comprehensive report on the presentations, workshops and
tours that they had participated in.
Once again one of our members is teaching a photography class at the community college.
(Continued on page 6)

Stan Hingston

Application for Membership in Prairie Region of Photographic Arts

I hereby apply for membership in the Prairie Region of Photographic Arts (PRPA).
Enclosed is my membership fee (payable to “PRPA”) of $20.00 ($10 if applying between January 1
and the June Outing). I understand that memberships expire June 30 of each year.
Name
Phone
Address
Email
I am a member of (photography club)
(or) I am joining as an individual rather than through a club
Date
Signature
Mail to: Irene Stinson, PRPA Membership Chairperson
449—2nd Avenue S.E., Swift Current, SK S9H 3J7

Postal Code

Phone (306)773-7320
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We enjoyed viewing the PRPA slide sets of the best of
the Russell, Everest and Travelling Salon competitions.
Many members attended Courtney Milne’s “Luminous
Landscapes” show in October at Swift Current.
We are now looking forward to the photo opportunities that the forthcoming season will offer.

Regina Photo Club

Report by Shirley J Gerlock
As of March 7th we have 110 members from Regina &
surrounding area and one from Alberta. We are currently
getting ready for the SaskAmateur competition in April.
There have been interesting presentations received
from members on hand colouring, photo preservation,
images from ghost towns, Moose Jaw Airshow, Ukraine,
Scotland and one of a collage of digital images, showing
what her 4.0 camera would do.
Some members meet on a Saturday morning for coffee, then go on a photo shoot around town or in the country, then display their images at the next meeting.

Northern Image Photographers
Report by Geoff Payton

The past year has been extremely busy for a club of 30
people. Displays are ongoing at the Victoria Hospital cafeteria, the Palliative Care Unit, the Senior’s Heritage Centre, the South Hill Mall, as well as a restaurant in neighboring Birch Hills. All displays are rotated every 8 weeks;
some 60 – 70 photos are on display at any given time. In
December and January we displayed the PRPA prints at
the South Hill Mall.
Throughout the warmer months, club members got
together often for various outings including Waskesiu and
P. A. National Park, to a nearby ranch to shoot newborn
foals, and several Centennial events such as Canoe Quest.
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June 2005 saw one of our “best ever” Weekend in the
Woods at Piprell Lake in northern Saskatchewan. About
15 members took part in the 3-day outing, traveling
through many areas in Narrow Hills Provincial Park, photographing from the top of a glacial esker, shooting cross
foxes from our doorstep, and were led to an eagle’s nest
where we watched (and shot!) the adults feed the young.
In September we held Weekend in the Woods #20 at
Sandy Lake in the National Park. Slide shows, equipment
demonstrations, plentiful food, and social and photographic opportunities again produced truly memorable
results. Weekend in the Woods #21 will be held June 9,
10, and 11 (they have been held on the second weekend in
both June and September for 11 years now) at McPhee
Lake, just outside the park’s eastern edge.
Monthly meetings continue to be well-attended, with
scheduled presentations on everything from timehonoured equipment and techniques to the latest in digital
photography. A monthly assignment for members is reviewed, on print, slide or digital. Coffee meetings are also
held monthly. At our last meeting, we selected our slides
for the upcoming Transparency Battle, which we hope to
attend with at least a dozen members.
As a community group, we participate with other organizations in various ways. In July our club annually
organizes and judges the P.A. Exhibition photography
competition. Our club provides the photography for the
Relay for Life each year. As well, we had an “insider’s”
tour of the Historical Museum, where some of our members volunteer. Several club members worked at the recent
Canadian Challenge, a sled dog race from Prince Albert to
La Ronge and back, in conjunction with either P.A. North
Search & Rescue, or the Lakeland Amateur Radio Association. We are involved with the P.A. AeroModellers in
an upcoming event to showcase the many different types
of clubs in the area. Previously, we have also had joint
BBQ/photo opportunities with the Northern Waters Flyfishing club, and presented slide shows to their club.
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Webmaster Report
by Wesley Swan webmaster@prpa.ca
Report not available this issue.

Photo Resolution for E-mail & Web
by Stan Hingston

When sending photos by email just for viewing on a
computer screen, you need to reduce the file size first.
There are two ways to do this: a) reduce the size of the
image and b) reduce the quality of the image. Note: if you
are sending a photo file for someone else to print, send as
big a file as you can (see my article in the last issue).
First reduce the size to that which will fit on their
screen. Using Photoshop click Image > Resize > Image
Size. Resample Image needs to be checked. Set the upper
width setting to 750 pixels. I find this is a good size for
viewing in my Outlook Email program viewing pane. This
will reduce the file size to a manageable 100-200 kb size.
To reduce the file size further, next use the File > Save
for Web function. This will reduce the file size by about
75% while leaving the image size the same and only
slightly reducing the visible quality (eg a 200 kb file will
become about 50) Note: using this function before resizing will not make any difference to file size or quality, so
do it in this order.
For photos to insert in a web page, first decide on what
size on the screen they are to be viewed. For full screen
viewing use 1280 pixels wide or 960 high; for smaller size
calculate accordingly (eg for 1/4 screen use 320 x 240).
Resize the photo to this size and then use Save for Web as
above. Finally use File > Save As and rename with an E
(for email) or W (for web) after the name to identify them.

Clara Hume (1914 - 2006)

Clara, wife of Clare Hume, passed away March 18, 2006,
at 91. Among Clara’s many accomplishments was her
painting. She started painting as a child and studied many
different art forms at the Technical School and at the U of
S. She was particularly noted for her detailed acrylic
paintings of prairie wildflowers and grasses, and prairie
landscapes. A celebration of Clara’s life will be held April
22 at the Saskatoon Funeral Home. Clare Hume (19092004) was a long time member of the Saskatoon Camera
Club and the namesake of the Transparency Battle trophy.
See Winter 2005 Prairie Focus for Clare’s obituary.

Print Competitions Deadline Error
I apologize for any confusion caused by the printing in
the last issue of the Print Competition deadline as April 1.
It should have been, as it always has, April 15. The deadline for getting your prints to your club rep to take to the
spring executive meeting would have been a day or so
prior to April 1, but you have to the 15th to mail them.
Stan Hingston, editor
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The Last Word

Editor Report by Stan Hingston
Surprise! One obvious change with this newsletter and
a few not so obvious.
This is the first issue on regular size paper instead of
the neat little booklets that we have had since sometime
before Sheina took over as editor about 1997. Here is the
story: The rates were going up at the Rosetown printshop
—Economy Stationary—where I have been getting the
newsletters printed, so I did some number crunching and
bought my own color laser printer—a Samsung CLP 510.
The ads said it would take up to 14” paper but didn’t say
you had to buy an expensive attachment. So my preferred
solution was to change the format.
I won’t know the exact cost until I see how many
copies I get with the toner cartridges, which should
happen during the printing of the Summer issue. For now I
am charging the same rate as quoted by the Saskatoon
Office Depot, $1.70 + tax per copy for an 8 page issue
with color covers. It may work out to be less.
One advantage of the change is that I now only have to
add pages by twos instead of fours which makes it easier
to fit everything in and fill the pages. Another is that
B&W photos (including ads) can be inserted anywhere at
no extra cost. Also, by doing all the printing myself I can
easily print more copies later as needed so there is little
advantage in making extra copies at the time of printing.
A disadvantage (to me anyway) is that I am back to
doing the copying and stapling myself (a not so obvious
change, I hope). I don’t mind the work though as it gives
me more control over the finished product.
Another not so obvious change in the newsletter is the
loss of the Konica Minolta ad. When I tried to contact
them about renewing for another year, I learned that the
company has gone out of photo equipment. Apparently a
victim of the digital revolution. Can any of you help find a
replacement advertiser?
I just learned (after printing 150 copies of page 2) that
Janice has resigned as PRPA rep for Foothills—watch for
her replacement in the next issue. Any other changes or
additions to the club website list or the club representative’s contact information on page 2?
The Outing information and registration forms are
printed on colored paper for easy identification and attached at the back for easy removal of the page to send in.
I am missing three issues from the Editor’s archive
collection: 41(3) with winter combine photo on the cover;
41(4) with the snowbank photo cover; and 43(1) Noel’s
issue. If you have an extra of any of these you would like
to donate, please bring them to the Outing. Thank you!

Submission Deadlines for the Newsletter
Winter: January 15
Spring: March 15

Summer: May 30
Fall: September 15
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Outing Competition
2005 Winners
See page 4 for complete list of winners,
categories, titles and
photographers.
Numbers on photos
refer to numbers in
[ ] in winners list.
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